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 TFS 43294  
Mass Scan / Import Document Processing 

This is an addition to PACS 10.0 to mass scan in documents to attach to many properties, or to import 
mass images or documents to attach to many properties. 

 Tools>Code Maintenance>General>Document Type 

The Document type codes will need to be set up before any mass scan or import can happen.  
To set up these codes the user must have the “Code Maintenance>General>Document Type” 
user right. 

Code:  User defined code for the document or image going to be mass scanned or imported 

Description:  Defines the code 

Image Type:  TIF or PDF can be selected and this field is mandatory 

Record Type:  The record type will have a drop down list that will be the based upon the Image 
Type.  This selection comes from the rect_type table.  The options will be code and description.  
This field is required 

Sub-type:  This will be a listing from the sub_type table which is based on the Image type and 
Record type selected.  This field is required. 

Activities>Forms Processing>Import Documents 

 This function will require the user have the “Activities>Document Import” user right 

 

 Import:  Located in the toolbar.  This button will invoke the dialog to prompt the user for the 
folder containing the documents or images to import 

Scan:  Located in the toolbar.  This button will invoke the dialog to prompt the user for the 
folder where the scanned documents will be stored for subsequent processing and initiate the 
mass scanning process. 

Once an import or mass scanning has been done there will be a listing with a run id on the 
Document Scan/Import Runs dialog. 

Process:  Located in the toolbar.  This button will allow the user to select a run id to process.  
This can only be used if the status is Imported or Complete. 
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Importing dialog – invoked from the tool bar will have an import path for the user to select the 
documents or images to import.   

 

The Import Path will be stored in [pacs_config] to be populated next time as the last path used as described above. 

a. The application will check if any files within the folder exist with the following extensions: 
PDF, JPG, PNG, TIFF, TIF 

If the selected folder does not contain any valid image files, the application will display the 
following error message:  

“The selected folder does not contain valid image records to be processed. Please 
select another folder.” 

  The import dialog will remain open, allowing the user to select a different folder. 

b. Once valid files are detected, the import dialog will be closed, and a standard PACS Progress 
Dialog will be shown that will display progress information over the run listing view. 

c.  The system will then begin the process of copying each file from the folder specified by the user 
to the import_path folder specified above.  As each file is copied, the following additional steps 
will be taken: 

i. The system will attempt to open the file as an image file.   
ii. The file will be processed to find a barcode.  The barcode text will have the 

following format: 
*{year}%{prop_id}%{document_type_cd}* 

For example, a DR-499 document in 2019 for property 12345 would have a barcode with 
the following text: 

*2019%12345%DR-499* 
i. When review for each document is completed, the application will add a record to the 

[import_document_run_record]  
ii. When the process is complete the grid will be updated with record count, error count 

and status (Imported) 
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Mass Scan 

This dialog will invoked from the button in the toolbar.  The Scan Path will need to be populated 

1.  Scan Path 
a. This field will allow the user to select the location of the folder where the scanned documents 

will be stored. 
b. This field will be pre-populated in the following way: 

i. It will be populated with the last path that was used (if any) by the current user. 
1.  
2. This will be retrieved from [pacs_user_settings] where pacs_user_id = Current 

User Id and settings_group = ‘DocumentImport’ and name = ‘last_scan_path’ 
ii. Otherwise, it will be blank. 

c. This field will be required. 
d. This field will only allow selection of existing folders, both locally or using a UNC path. 

i. The user will be able to type the desired path or click on the ellipsis button to select one. 
 

2. Duplex 
a. This field will allow the user to specify whether they’d like the scanner to scan both sides of the 

documents. 
b. This feature will only work if the scanner can do duplex scanning. 

 

3. Scan Button 
a. The Scan Path will be stored in [pacs_config] to be populated next time as the last path used as 

described above. 
b. The scan dialog will be closed and a standard PACS Progress Dialog will be shown that will display 

progress information over the run listing view.   
c. A new run record will be created in the [import_document_run] table: 

 
d. The system will engage with the user’s scanner and start the scanning process.  The system will 

automatically process every page that is loaded in the scanner’s tray. 
i. If an error occurs attempting to communicate with the scanner, then an error will be 

shown to the user “Could not communicate with scanner:” followed by any pertinent 
error message returned by the TWAIN scanner library. 

ii. Every page will be processed to find a barcode.  Documents could be multiple pages, so 
each new document will start whenever a new barcode is detected.  The barcode text 
will have the following format: 

*{year}%{prop_id}%{document_type_cd}* 
For example, a DR-499 document in 2019 for property 12345 would have a barcode with 
the following text: 

*2019%12345%DR-499* 
iii. Documents will be saved to the Scan Path selected by the user. 

1. Documents will be saved in the format configured in the Image Type selected 
for the Document Type Code with the following file name:  

<Year>_<Document Type Code>_<Property ID>.tif 

2. If a file with the name already exists, it will be overwritten. 
3. If the barcode is invalid and the year, prop_id, and document type cannot be 

parsed from it, the scanned image is still saved to the folder, but with the 
following file name instead: 

Unrecognized_Barcode_####.tif 
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where ##### is a number starting with 0001 and incrementing for each 
document that could not be read. 

iv. When each document is saved to the folder, the application will add a record to the 
[import_document_run_record]  

b. When scanning is complete: 
i. The process will update the [import_document_run] record created in step b: 

record_count = count of the number of documents in the folder 
error_count = count of number of “Unrecognized barcode format” errors. 
status = ‘Imported’ 

ii. The progress dialog will automatically close and the listing view’s grid will be refreshed 
to display the new run. 

 

Process 

This will be invoked by using the Process button in the toolbar.  Ensure the row of imported or scanned 
documents/images is highlighted. 

1.  The application will prompt the user with the following question: 
“Do you want to delete files from the source folder at ‘{import_document_run.import_path}’ as 
they are processed and uploaded to the property imaging system’s folder in PACS?” 

If the user confirms by clicking ‘Yes’, then files that have been successfully processed in the steps below 
will be deleted. 

 

2. The [import_document_run].status field for the selected run will be updated to ‘Processing’. 
 

3. Each row in the [import_document_run_record] table for the selected run meeting the following 
conditions will be processed: 

a. processed = 0 (indicating the row has not been previously processed). 
b. error_message is NULL 
c. prop_id is not null 
d. document_type_cd is not null 
e. year is not null 

 

For each row: 

a. The document_type_cd value will be used to look up the image_type, rect_type, and sub_type 
codes to associate with the image document from the document_type table. 

b. The PACS Imaging library will be called to upload the file to the imaging folder specified by the 
UNC path stored in the pacs_imaging table. 

c. A new record will be added to pacs_image table to associate the uploaded image with the 
property: 
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d.  
 

Column Value 
image_id {New ID} 
image_type {image_type} from step a 
location {uploaded image path and file name} 
image_nm {file name of uploaded image} 
scan_dt {import_document_run.imported_date} 
expiration_dt NULL 
sub_type {sub_type} from step a 
rec_type {rect_type} from step a 
  
eff_yr {import_document_run_record.document_year} 
status_cd NULL 
status_dt NULL 
comment NULL 
image_dt {Current Date and Time} 
chg_reason NULL 
pacs_user_id {PACS User ID} 
status_user_id NULL 
ref_id {prop_id} 
ref_type ‘P’ 
ref_year {import_document_run_record.document_year} 

 
 

e. Set [import_document_run_record].process = 1 for the current record. 
f. If the user chose the option to delete the source document from the import folder, the 

application will delete the file. 
 

4. When all the records for the run have been processing, the application will update the following fields in 
the [import_document_run] table. 
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TFS 41579 
 

The existing DR 409/ DR 409 A will be modified to include a section for the DR 409A.   

 

This dialog is reached in either of the following ways: 

1. Main Application Button->Activities->Roll Correction->Roll Correction Group 
Maintenance, right click on a Roll Correction Group, choose the “Generate the 
Certificate of Correction (DR-409)” option 

a. The current menu option name will be modified to “Generate the Certificate of 
Correction (DR-409 / DR409A)”. 

b. This option will only be available if the user has the Roll Correction 
Administration feature with the Execute privilege. 

 
2. Open a Property, choose Commands->Roll Correction-> Generate the Certificate of 

Correction (DR-409) option 
a. The current menu option name will be modified to “Generate the Certificate of 

Correction (DR-409 / DR409A)”. 
b. This option will only be available if all of the following are true 

i. The Property opened must be in a Roll Correction 
ii. The user must have the Roll Correction Process feature with the Execute 

privilege. 
c. If the Property is being Roll Corrected and the Recalculation Status is not 

Current, the user will receive the following message: 
“The property should be recalculated prior to printing the Certificate of Correction 

to insure all values are accurate.” 

 

 

The DR-409 Certificate of Roll Correction Report dialog will be modified as follows: 
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a. The name will be modified to “DR-409/DR-409A Certificate of Roll Correction 
Report”. 
 

b. The Description field (bolded title) will be modified to “DR-409/DR-409A Certificate 
of Roll Correction Report”. The description body will not be modified. 

 

c. New separate sections will be created, one for “DR-409 Report” and the other for 
“DR-409A Report”. 

i.  The user will be allowed to select through checkbox options whether to 
print: 

1. The existing DR-409 Report  
a. Note: The existing checkbox for ‘DR-409 Roll Correction Tax 

Calculator Worksheet’ will continue to remain under the “DR-
409 Report” section. 

2. The new DR-409a Report 
3. The user will be allowed to select one or both options 
4. The default will be both. 

 
ii. The user will select the changes made on the property to print 

1. A checkbox will be added for the following options: 
a. Print Legal Description Change 

i. This option will print any modified Legal Description on 
the property. 

b. Print Rate/Basis Change 
i. This option will print the ‘From’ and ‘To’ values of any 

modified Special Assessment Rate for the selected 
Agency on the property. 

c. Print Non-Advalorem Assessment Change 
i. This option will print the ‘From’ and ‘To’ values of any 

modified Special Assessment Fee for the selected 
Agency on the property 

 

iii. The user will be allowed to specify the Agencies for which the report will be 
printed 

1. The default will be all distinct special assessment agencies as carried 
on the property prior to the current roll correction plus the current 
roll correction.  

a. All assessment agencies on the property in the previous roll 
correction (or Supp 0) 

b. All assessment agencies on the property in the current roll 
correction.  
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c. Each Special Assessment Agency will be displayed only once. 

2. One or more agencies can be selected via a Code chooser dialog. 
3. At least one agency selection is required. 

 

d. Selecting ‘Preview’ or ‘Print’ after making the needed report dialog selections will 
generate the new DR-409A form(s). 

 

e. The report will be generated for each selected agency on the property (one report 
page per agency). 

TFS 

 

TFS 42408  
 

Added verification to sales and an export for sales information 

Tools>System Configuration>Imports/ Exports >Exports>Sales Export – this will allow you to pick the 
deed types that exist in PACS 10.0 that you want to be the default setting in the export dialogue.  

Activities>Export>Sales 
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The deed types you see selected are the ones chosen in the System Configuration for the Sales Export 

 

Export layout: is tab delimited 

And separate document in the release docs  
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Sales Verification has added some new information to the sales on a property. 

An Images tab now exists under Ownership History 

Owner ship history – image and sales review – hard coded data reason 
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Sale Price Panel 

Sale price panel has 3 new fields added 

Buyer Settle – this is a user entered amount 

Seller Settle – this is a user entered amount 

Cost of Sale is a calculated field = (Buyer Settle + Seller Settle) / Adjusted sale price 
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Sale Information Panel 

Support file – choose any pdf file that supports the sale.  Once the file in listed there will be a go button.  
The GO will open the doc and find all the places the GEO id exists 

Verified by is based on the DOR qualify chosen and the verified by will be updated with the user name of 
the user that updated the DOR qualify code 

 

Co star on file updated by the codes entered by user 

Status is also updated by the user 

 

Sale search  

Now has the Property sub type,  Verified By and Verification dates as search options to find properties. 
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TFS 42451  
CRA / TIFF Reporting 

Home>Reports>CRA/TIF Reports 

Following options will be available under it.  

 

1.  “CRA/TIF DR 420” 
a. This new option will be added to Home > Reports > CRA/TIF. 
b. On click of this option the existing “Print DR-420 TIF Report” dialog will open. 

This dialog will have the option to enter the Tif Zone in the parameters.  
 

2. CRA/TIF Property Use Summary 
a. This new option will be added to Home > Reports > CRA/TIF. 
b. On click of this option the new “Print CRA/TIF Property Use Summary Report” 

dialog will open. This dialog will allow the user to print the “CRA/TIF Property 
Use Summary” Report.  

3. CRA/TIF Property Detail Report 
a. This new option will be added to Home > Reports > CRA/TIF. 
b. On click of this option the new “Print CRA/TIF Property Detail Report” dialog will 

open. This dialog will allow the user to print the CRA/TIF Property Detail Report.  
DR 420 

Parameters will be Year, TIF Zone or CRA (choose one, many or all), As of (Roll correction, Preliminary 
Certification, Certification, Final Certification), Output Settings  

This will print the existing DR 420 TIF that was available from the Activities>Tif Zone Listing. 

 

CRA/TIF Property Use Summary Report 

Parameters will be Year, TIF Zone or CRA (choose one, many or all), As of (Roll correction, Preliminary 
Certification, Certification, Final Certification), Output Settings  

Columns: Description of the Use|Market Value|SOH Value|County Taxable|School Taxable| Mun(icipal) 
Taxable|Dist(rict) Taxable|Parcels  
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The report will have the following fields in the Heading: 

 

1. <County Name> 
a. This field will display the county name 

2. <Print Date/Time> 
a. This field will display the date and time the report is printed. 

3. for <CRA Tif Zone Code (CRA) > 
a. This will display : 

i. The  [tif_zone ].tif_zone_cd  for “CRA Tif Zone Code” that was selected in 
the input parameters in Figure 5.3a 

ii. The [tif_zone ].community_redevelopment_area  for “CRA” 
corresponding to the Tif Zone Code. 

iii. The value of this field will come from 
[tif_property_use_summary_report_vw].tif_zone_cd and 
[tif_property_use_summary_report_vw]. 
community_redevelopment_area 

 
4. Year 

a. This field will display the Year the user chose in Figure 5.3a 
b. The value of this field will come from 

[tif_property_use_summary_report_vw].year 
5. As Of 

a. This field will display the type of As Of (“RC”, “PC”, “C”, or “FC”) the user chose in 
Figure 5.3a 

b. The value of this field will come from 
[tif_property_use_summary_report_vw].as_of 

6. RC # 
a. This field will display the As of Roll Correction # the user chose in Figure 5.3a. 
b. The value of this field will come from 

[tif_property_use_summary_report_vw].sup_num 
 

The report will have the following columns with data obtained from 
tif_property_use_summary_report_vw: 

 

1. Description 
a. This column will display the primary use code found for the properties contained 

within that TIF (CRA) Zone. The Description will show the Primary use code along 
with the Description 

i. The value of this field will come from 
[tif_property_use_summary_report_vw].description.  
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ii. This value will actually represent “[property_val].property_use_cd 

( [property_use].property_use_desc)”. 
2. Market Value    

a. This column will display the sum of the market values for each property type in 
the result set. 

i. The value of this field will come from 
[tif_property_use_summary_report_vw].total_market_val 

ii. This value will represent the sum of [property_val].market for the 
corresponding properties. 

3. SOH Value  
a. This column will display the sum of the market value for ‘SOH’ cap type.  

i. The value of this field will come from 
[tif_property_use_summary_report_vw].total_soh_val 

ii. This value will represent the sum of 
[property_cap_type_value].total_market_val where 
property_cap_type_value.cap_type = ‘SOH’ for the corresponding 
properties. 

4. County Taxable 
a. This column will display the sum of the county taxable value of the properties for 

that property use type in the result set. 
i. The value of this field will come from 

[tif_property_use_summary_report_vw].total_county_taxable_val 
ii. This value will represent the sum of [property_val].taxable_val for the 

corresponding properties. 
5. School Taxable 

a. This column will display the sum of the school taxable value of the properties for 
that property use type in the result set. 

i. The value of this field will come from 
[[tif_property_use_summary_report_vw].total_school_taxable_val 

ii. This value will represent the sum of [property_val].school_taxable_val for 
the corresponding properties. 
 

6. Municipal Taxable 
a. This column will display the sum of the municipal taxable value of the properties 

for that property use type in the result set. 
i. The value of this field will come from 

[tif_property_use_summary_report_vw].total_municipal_taxable_val 
ii. This value will represent the sum of [property_val].municipal_taxable_val 

for the corresponding properties. 
7. Independent Special District Taxable – this is a new value being added to the property 

per the Broward Trim Use case 
a. This column will display the sum of the Independent Special District taxable 

value of the properties for that property use type in the result set. 
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i. The value of this field will come from 

[tif_property_use_summary_report_vw].total_isd_taxable_val 
ii. This value will represent the sum of [property_val].isd _taxable_val for 

the corresponding properties. 
8. Number of Parcels  

This column will display the number of properties the TIF (CRA) zone has for that 
primary use type. 

i. The value of this field will come from 
[tif_property_use_summary_report_vw].no_of_parcels 

 

Display a summary section at the bottom of every Tif Zone Summary report page detailed 
above.  The data for this section will be obtained from 
tif_property_use_summary_totals_report_vw. 
The summary section will display the following fields: 
 
1. 25 K HOMESTEAD  <# of properties>  <Total Value> 

b. This field will display the HEX exemption, number of properties with the 
exemption and the sum of the exemption value. 
The display will consist of  

i. “25 K HOMESTEAD” 
ii. <# of properties>  

1. The total number of properties for the Tif Zone , year and roll 
correction that have an exemption of ‘HEX’  

2. The value of this field will come from 
[tif_property_use_summary_totals_report_vw].total_no_of_hex 

3. This value will represent the count of [property_exemption] 
where corresponding [exemption].exemption_cd is ‘HEX’. 

4. If the exemption value on any property is 0, that property will not 
be counted. 
 

iii. <Total Value> 
1. The sum of the exemption value on properties for the Tif Zone , 

year and roll correction that have an exemption of ‘HEX’  
2. The value of this field will come from sum of 

[tif_property_use_summary_totals_report_vw].total_hex_value 
3. This value will represent the sum of 

[property_taxing_authority_exemption_val].granted_exemption_
amt where corresponding [exemption].exemption_cd is ‘HEX’. 

2. 50 K HOMESTEAD  <# of properties>  <Total Value> 
a. This field will display the Hex A exemption, number of properties with the 

exemption and the sum of the exemption value. 
The display will consist of  
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i. “50 K HOMESTEAD” 

ii. <# of properties>  
1. The total number of properties for the Tif Zone , year and roll 

correction that have an exemption of ‘HEX-A’ 
2. The value of this field will come from 

[tif_property_use_summary_totals_report_vw].total_no_of_hexA 
3. This value will represent the count of [property_exemption] 

where corresponding [exemption].exemption_cd is ‘HEX-A’. 
4. If the exemption value on any property is 0, that property will not 

be counted. 
iii. <Total Value> 

4. The sum of the exemption value on properties for the Tif Zone , 
year and roll correction that have an exemption of ‘HEX-A 

5. The value of this field will come from sum of 
[tif_property_use_summary_totals_report_vw].total_hexA_value 

6. This value will actually represent the sum of 
[property_taxing_authority_exemption_val].granted_exemption_
amt where corresponding [exemption].exemption_cd is ‘HEX-A’. 

3. County Seniors  <# of properties>  <Total Value> 
b. This  field will display the details of exemptions mapped to the 196.075 statute 

for the County Taxing Authority on properties with the Tif Zone , year and roll 
correction. 
The display will consist of  

i. “County Seniors” 
ii. <# of properties>  

1. The total number of properties  with Exemptions mapped to the 
196.075 statute for the County Taxing Authority on properties 
with the selected Tif Zone, year and roll correction 

2. The value of this field will come from 
[tif_property_use_summary_totals_report_vw].total_no_of_coun
ty_seniors 

3. This value will actually represent the count of 
[property_exemption] where exemption_id is one of 
[exemption_statute] where dor_statute_cd = ‘196.075’ and 
levy_cd is [tax_area_year].county_levy_cd where tax_area_id is 
[property_tax_area].tax_area_id for the relevant properties. 

4. If the exemption value on any property is 0, that property will not 
be counted. 

iii. <Total Value> 
1. The sum of the Value of Exemptions mapped to the 196.075 

statute for the County Taxing Authority on properties with the 
selected Tif Zone, year and roll correction  
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2. The value of this field will come from sum of 

[tif_property_use_summary_totals_report_vw]. total_ 
county_seniors _value 

3. This value will actually represent the sum of 
[property_taxing_authority_exemption_val].granted_exemption_
amt where exemption_id is one of [exemption_statute] where 
dor_statute_cd = ‘196.075’ and levy_cd is 
[tax_area_year].county_levy_cd where tax_area_id is 
[property_tax_area].tax_area_id for the relevant properties. 

 

4. City Seniors  <# of properties>  <Total Value> 
a. This field will display the details of exemptions mapped to the 196.075 statute 

for the Municipal Taxing Authority on properties with the Tif Zone, year and roll 
correction. 
The display will consist of  

i. “City Seniors” 
ii. <# of properties>  

1. The total number of properties with Exemptions mapped to the 
196.075 statute for the Municipal Taxing Authority on properties 
with the selected Tif Zone, year and roll correction 

2. The value of this field will come from 
[tif_property_use_summary_totals_report_vw]. 
total_no_of_municipal_seniors 

3. This value will actually represent the count of 
[property_exemption] where exemption_id is one of 
[exemption_statute] where dor_statute_cd = ‘196.075’ and 
levy_cd is [tax_area_year].municipal_levy_cd where tax_area_id 
is [property_tax_area].tax_area_id for the relevant properties. 

4. If the exemption value on any property is 0, that property will not 
be counted. 
 

iii. <Total Value> 
1. The sum of the Value of Exemptions mapped to the 196.075 

statute for the Municipal Taxing Authority on properties with the 
selected Tif Zone, year and roll correction  

2. The value of this field will come from sum of 
[tif_property_use_summary_totals_report_vw].total_municipal_s
eniors_value 

3. This value will actually represent the sum of 
[property_taxing_authority_exemption_val].granted_exemption_
amt where exemption_id is one of [exemption_statute] where 
dor_statute_cd = ‘196.075’ and levy_cd is  
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4. [tax_area_year].municipal_levy_cd where tax_area_id is 
[property_tax_area].tax_area_id for the relevant properties. 
 

5. Widow/Veterans/Disabled <# of properties> <Total Value> 
a. This field will display the details of exemptions mapped to the 196.202 or 196.24 

statute for the properties with the Tif Zone, year and roll correction user 
parameters. 
The display will consist of  

i. “Widow/Veterans/Disabled” 
ii. <# of properties>  

1. The total number of properties with Exemptions mapped to the 
196.202 or 196.24 statute for properties with the selected Tif 
Zone, year and roll correction report parameters. 

2. The value of this field will come from 
[tif_property_use_summary_totals_report_vw]. total_no_of_wvd 

3. This value will represent the count of [property_exemption] 
where exemption_id is one of [exemption_statute] where 
dor_statute_cd = ‘196.202 or 196.24’ for the relevant properties. 

4. If the exemption value on any property is 0, that property will not 
be counted. 

iii. <Total Value> 
1. The sum of the Value of Exemptions mapped to the 196.202 or 

196.24 statute for the properties with the selected Tif Zone, year 
and roll correction report parameters. 

2. The value of this field will come from 
[tif_property_use_summary_totals_report_vw].total_wvd_value 

3. This value will represent the sum of 
[property_taxing_authority_exemption_val].granted_exemption_
amt where exemption_id is one of [exemption_statute] where 
dor_statute_cd = ‘196.202 or 196.24’ for the relevant properties. 
 

6. Portability Granted <# of properties> <Total Value> 
a. This field will display the details of applications with portability granted status for 

the properties with the Tif Zone, year and roll correction user parameters. 
The display will consist of  

i. “Portability Granted” 
ii. <# of properties>  

1. The total number of properties with Portability Granted 
application status from properties with the selected Tif Zone, year 
and roll correction report parameters. 

2. The value of this field will come from 
[tif_property_use_summary_totals_report_vw]. 
total_no_of_portability_granted 

  



22 
 

 
3. This value will represent the count of [application] where 

[application_portability_status].type = ‘A’  for the properties with 
the selected Tif Zone , year and roll correction. 

iii. <Total Value> 
1. The sum of the portability amount for properties with Portability 

Granted application status from properties with the selected Tif 
Zone, year and roll correction report parameters. 

2. The value of this field will come from sum of 
[tif_property_use_summary_totals_report_vw].total_portability_
granted. 

3. This value will represent the sum of 
[application_portability].portability_amount where 
[application_portability_status].type = ‘A’ for the relevant 
properties. 

 
7. Ag Parcels <# of properties> <Total Value> 

b. This field will display the properties with Ag  values from the properties with the 
Tif Zone, year and roll correction user parameters. 
The display will consist of  

iv. “Ag Parcels” 
v. <# of properties>  

1. The total number of Ag parcels with the selected Tif Zone, year 
and roll correction report parameters. 

2. The value of this field will come from 
[tif_property_use_summary_totals_report_vw]. 
total_no_of_ag_parcels. 

3. This value will represent the count of properties where 
[land_detail]. ag_apply= ‘T’  and  [land_detail].ag_use_cd is not 
null or empty and the corresponding [ag_use].ag = 1 for the 
relevant properties. 

vi. <Total Value> 
1. The sum of the Productivity Value for Ag properties and the 

selected Tif Zone, year and roll correction report parameters. 
2. The value of this field will come from 

[tif_property_use_summary_totals_report_vw].total_ag_value. 
3. This value will represent the sum of [property_val].ag_use_val of 

the relevant properties. 
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CRA/TIF Property Detail Report 

Parameters will be Year, TIF Zone or CRA (choose one, many or all), Property Use Type (one, many, all), 
As of (Roll correction, Preliminary Certification, Certification, Final Certification), Output Settings  

The document will display the following columns : 

 

1. Property_Id 
a. This field will display the property id. 

i. The value of this field will come from [tif_details_report].Property_Id. 
ii. This value will represent [property_val].prop_id. 

2. Geo_Id  
a. This field will display the geo id of the property. 

i. The value of this field will come from [tif_details_report].Geo_Id. 
ii. This value will represent [property].geo_id 

3. First_Name  
a. This field will display the first name of the primary owner of the property. 

i. The value of this field will come from [tif_details_report].First_Name. 
ii. This value will represent [account].first_name where 

[owner].primary_owner = 1 
4.   Last_Name  

a. This field will display the last name of the primary owner of the property. 
i. The value of this field will come from [tif_details_report].Last_Name. 

ii. This value will represent [account].last_name where 
[owner].primary_owner = 1 

5. Columns for each primary mailing address line of the primary owner of the property 
a. Address_Line_1 - This field will display the first line of the address. 

i. The value of this field will come from [tif_details_report].Address_Line_1. 
ii. This value will actually represent [address].addr_line1 where 

[address].primary_addr = "Y" for the primary owner 
b. Address_Line_2 - This field will display the second line of the address. 

i. The value of this field will come from [tif_details_report].Address_Line_2. 
ii. This value will represent [address].addr_line2 where 

[address].primary_addr = "Y" for the primary owner 
c. Address_Line_3 - This field will display the third line of the address. 

i. The value of this field will come from [tif_details_report].Address_Line_3. 
ii. This value will represent [address].addr_line3 where 

[address].primary_addr = "Y" for the primary owner. 
d. City - This field will display the city. 

i. The value of this field will come from [tif_details_report].City. 
ii. This value will represent [address].addr_city where 

[address].primary_addr = "Y" for the primary owner. 
e. State - This field will display the state. 

i. The value of this field will come from [tif_details_report].State. 
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ii. This value will represent [address].addr_state where 

[address].primary_addr = "Y" for the primary owner. 
f.  Zip - This field will display the zip code. 

i. The value of this field will come from [tif_details_report].Zip. 
ii. This value will represent [address].addr_zip where 

[address].primary_addr = "Y" for the primary owner. 
g. Zip4 - This field will display the 4-digit zip. 

i. The value of this field will come from [tif_details_report].Zip4. 
ii. This value will actually represent [address].zip_4_2 where 

[address].primary_addr = "Y" for the primary owner. 
 

6. Columns for legal desc 
The full legal description will be split in different columns of 30 characters rounded to 
words so that they are legible in the excel. 

i. The column names will be displayed as LEGAL_LINE_1, LEGAL_LINE_2 and 
so on 

ii. The value of the full legal description will come from 
[tif_details_report].legal_desc. 

iii. This value will represent combination of [property_val].legal_desc and 
[property_val].legal_desc_2 . 

iv. See section 6.1 part 2 (CRA/TIF Property Detail Report) for information on 
how to split the [legal_desc] field. 

7.  Millage_Code 
a. This field will display the tax area code of the property. 

i. The value of this field will come from [tif_details_report].Millage_Code. 
ii. This value will represent [tax_area].tax_area_number corresponding to 

the property in [property_tax_area] 
8.   Primary_Use_Code  

a. This field will display the property use code of the property. 
i. The value of this field will come from 

[tif_details_report].Primary_Use_Code. 
ii. This value will represent [property_val].property_use_cd. 

9.  Just_Land_Value 
a. This field will display the land value of the property. 

i. The value of this field will come from 
[tif_details_report].Just_Land_Value. 

ii. This value will actually represent : 
[property_val].ag_market + [property_val].timber_market + 
[property_val].land_hstd_val + [property_val].land_non_hstd_val + 
[property_val].classified_land_mkt_val 

10. Just_Improvement_Value 
a. This field will display the improvement value of the property. 
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i. The value of this field will come from [tif_details_report]. 

Just_Improvement_Value. 
ii. This value will represent: 

[property_val].imprv_hstd_val + [property_val].imprv_non_hstd_val + 
[property_val].classified_imprv_mkt_val 
  

11. Just_Other_Value 
a. This field will display the land value of the property that does not have an Ag 

apply. 
i. The value of this field will come from 

[tif_details_report].Just_Other_Value. 
ii. This value will actually represent  the sum of the land value for the land 

details where [land_detail].ag_apply is not 'T' or ([ag_use].timber = 0 and 
[ag_use].ag = 0 )  

iii. The land value will be calculated as follows: 
case [property_val].appr_method  
when 'C' then [land_detail].land_seg_mkt_val  
when 'I' then [land_detail].land_seg_mkt_val  
when 'D' then [land_detail].dist_val  
when 'A' then [land_detail].arb_val  
when 'G' then [land_detail].mktappr_val 

 

12. New_SOH_Value 
a. This field will display the homestead value of the property. It will be the County 

Assessed Value. 
i. The value of this field will come from 

[tif_details_report].New_SOH_Value. 
ii. This value will actually represent : 

[property_cap_type_value].assessed_val for that property where 
[property_cap_type_value].cap_type = 'SOH' 
 

13. New_SB_SOH_Value 
a. This field will display the School Assessed Value. 

i. The value of this field will come from 
[tif_details_report].New_SB_SOH_Value. 

ii. This value will represent [property_val].school_assessed_val 
 

14. Hex_Value 
a. This field will display the HEX value of the property.  

i. The value of this field will come from [tif_details_report].Hex_Value. 
ii. This value will actually represent : 
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[property_taxing_authority_exemption_val].granted_exemption_amt 
where corresponding [exemption].exemption_cd is ‘HEX’ for that 
property. 

15. HexA_Value 
a. This field will display the HEXA value of the property.  

i. The value of this field will come from [tif_details_report].HexA_Value. 
ii. This value will actually represent : 

[property_taxing_authority_exemption_val].granted_exemption_amt 
where corresponding [exemption].exemption_cd is ‘HEX-A’ for that 
property. 

16. Disabled_Veteran_Amount 
a. This field will display the sum of the Value of Exemptions mapped to the 196.202 

or 196.24 statute for the property with the selected Tif Zone, year and roll 
correction report parameters.  

i. The value of this field will come from 
[tif_details_report].Disabled_Veteran_Amount. 

ii. This value will actually represent : 
the sum of 
[property_taxing_authority_exemption_val].granted_exemption_amt 
where exemption_id is one of [exemption_statute] where dor_statute_cd 
= ‘196.202 or 196.24’ for the relevant property. 

17. County_Exemption_Value 
a. This field will display the County Exemption value for the property with the 

selected Tif Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].County_Exemption_Value. 
ii. This value will actually represent [property_val].exemption_val. 

18. School_Exemption_Value 
a. This field will display the School Exemption value for the property with the 

selected Tif Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].School_Exemption_Value. 
ii. This value will actually represent [property_val].school_exemption_val. 

 
19. City_Exemption_Value 

a. This field will display the City Exemption value for the property with the selected 
Tif Zone, year and roll correction report parameters.  

i. The value of this field will come from 
[tif_details_report].City_Exemption_Value. 

ii. This value will represent sum of 
[property_taxing_authority_exemption_val].granted_exemption_amt  
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iii. where [tax_area_year].municipal_levy_cd = 
[property_taxing_authority_exemption_val].levy_cd for the relevant 
property. 
 

20. ISD_Exemption_Value 
a. This field will display the Independent special district Exemption value for the 

property with the selected Tif Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].ISD_Exemption_Value. 
ii. This value will represent sum of 

[property_taxing_authority_exemption_val].granted_exemption_amt 
where [tax_area_year].isd_levy_cd = 
[property_taxing_authority_exemption_val].levy_cd for the relevant 
property. 
 

21. County_Taxable_Value 
a. This field will display the County taxable value for the property with the selected 

Tif Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].County_Taxable_Value. 
ii. This value will represent [property_val].taxable_val. 

 
22. School_Taxable_Value 

a. This field will display the School taxable value for the property with the selected 
Tif Zone, year and roll correction report parameters.  

i. The value of this field will come from 
[tif_details_report].School_Taxable_Value. 

ii. This value will represent [property_val].school_taxable_val. 
 

23. City_Taxable_Value 
a. This field will display the City taxable value for the property with the selected Tif 

Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].City_Taxable_Value. 
ii. This value will represent [property_val].municipal_taxable_val. 

 

24. ISD_Taxable_Value 
a. This field will display the Independent special district taxable value for the 

property with the selected Tif Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].ISD_Taxable_Value. 
ii. This value will represent [property_val].isd_taxable_val. 

25. WVD_Type  



29 
 

 
a. This field will display a comma separated list of the exemptions under the DOR 

statute 196.202 or 196.24 for the property with the selected Tif Zone, year and 
roll correction report parameters.  

i. The value of this field will come from [tif_details_report].WVD_Type 
ii. The values will represent [exemption].exemption_cd for the exemptions 

of the property( [property_exemption] ) where exemption_id is one of 
[exemption_statute] where dor_statute_cd = ‘196.202 or 196.24’ for the 
relevant property 

26. Exemptions 
a. This field will display a comma separated list of the exemptions for the property 

with the selected Tif Zone, year and roll correction report parameters.  
i. The value of this field will come from [tif_details_report].exemptions_list. 

ii. These values will represent [exemption].exemption_cd where 
[exemption].exemption_id = [property_exemption].exemption_id for the 
relevant property. 

27. Columns for Special Assessment Code and Value 
The special assessment codes and the corresponding values for the property will be split 
in different columns. 

a. The column headers will be displayed in the following order as follows:  
i. Special Assessment 1  

ii. Special Assessment 1 Value  
iii. Special Assessment 2  
iv. Special Assessment 2 Value 

And so on. 
b. The value of the “Special Assessment X” fields will come from 

[tif_details_report].special_assessment_code_list. 
This field will be a comma delimited string of 
[special_assessment_agency].assessment_cd  where the 
[special_assessment_agency].agency_id = 
[property_special_assessment].agency_id for the relevant property. 
This field will be split into the columns Special Assessment 1, Special Assessment 
2 etc. using the comma delimiter. 

c. The value of the “Special Assessment X Value” fields will come from 

[tif_details_report].special_assessment_fee_list. 
This field will be a comma delimited string of 
[property_special_assessmen].sa_fee for the relevant property. 
This field will be split into the columns Special Assessment 1 Value, Special 
Assessment 2 Value etc. using the comma delimiter. 

28. Situs_Street_Number 
a. This field will display the Situs Street Number for the property with the selected 

Tif Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].Situs_Street_Number. 
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ii. This value will represent [situs].situs_num. 

29. Situs_Street_Prefix 
a. This field will display the Situs Street Prefix for the property with the selected Tif 

Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].Situs_Street_Prefix. 
ii. This value will represent [situs].situs_street_prefx. 

30. Situs_Street 
a. This field will display the Situs Street for the property with the selected Tif Zone, 

year and roll correction report parameters.  
i. The value of this field will come from [tif_details_report].situs_street. 

ii. This value will represent [situs].situs_street. 
31. Situs_Street_Suffix 

a. This field will display the Situs Street Suffix for the property with the selected Tif 
Zone, year and roll correction report parameters.  

i. The value of this field will come from 
[tif_details_report].Situs_Street_Suffix. 

ii. This value will represent [situs].situs_street_sufix. 
32. Situs_City 

a. This field will display the Situs City for the property with the selected Tif Zone, 
year and roll correction report parameters.  

i. The value of this field will come from [tif_details_report].Situs_City. 
ii. This value will represent [situs].situs_city. 

33. Situs_Zip 
a. This field will display the Situs Zip for the property with the selected Tif Zone, 

year and roll correction report parameters.  
i. The value of this field will come from [tif_details_report].Situs_Zip. 

ii. This value will represent [situs].situs_zip. 
34. Situs_Unit_Number 

a. This field will display the Situs Unit Number for the property with the selected Tif 
Zone, year and roll correction report parameters.  

i. The value of this field will come from 
[tif_details_report].Situs_Unit_Number. 

ii. This value will represent [situs].situs_unit. 
35. Senior_Exemption_County_Amount 

a. This field will display the ‘Senior Exemption County Amount’ for the property 
with the selected Tif Zone, year and roll correction report parameters.  

i. The value of this field will come from 
[tif_details_report].Senior_Exemption_County_Amount. 

ii. This value will actually represent the 
[property_taxing_authority_exemption_val].granted_exemption_amt 
where exemption_id is one of [exemption_statute] where dor_statute_cd 
=  
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‘196.075’ and levy_cd is [tax_area_year].county_levy_cd where 
tax_area_id is [property_tax_area].tax_area_id for the relevant property. 

36. Senior_Exemption_City_Amount 
a. This field will display the ‘Senior Exemption City Amount’ for the property with 

the selected Tif Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].Senior_Exemption_City_Amount. 
ii. This value will actually represent the 

[property_taxing_authority_exemption_val].granted_exemption_amt 
where exemption_id is one of [exemption_statute] where dor_statute_cd 
= ‘196.075’ and levy_cd is [tax_area_year].municipal_levy_cd where 
tax_area_id is [property_tax_area].tax_area_id for the relevant property. 

37. Portability  
a. This field will display ‘T’ if the property has a Portability Granted application 

status otherwise it will display a blank value.  
i. The value of this field will come from [tif_details_report].Portability. 

ii. This value will be determined to be ‘T’ if the property has any 
applications  [application] where [application_portability_status].type = 
‘A’. 

38. Portability_Amount 
a. This field will display the Portability Amount  on the property.  

i. The value of this field will come from 
[tif_details_report].Portability_Amount. 

ii. This value will represent the [application_portability].portability_amount 
where [application_portability_status].type = ‘A’ for the relevant 
property. 

39. Affordable_Housing 
a. This field will display the exemption under the DOR statute 196.1978  for the 

property with the selected Tif Zone, year and roll correction report parameters.  
i. The value of this field will come from 

[tif_details_report].Affordable_Housing. 
ii. The value will represent [exemption].exemption_cd for the exemptions 

of the property( [property_exemption] ) where exemption_id is of 
[exemption_statute] where dor_statute_cd = ‘196.1978’ for the relevant 
property. 

 

40. Affordable_Housing_Percent 
a. This field will display exemption percent of the exemption under the DOR statute 

196.1978  for the property with the selected Tif Zone, year and roll correction 
report parameters.  There would be only one exemption for a property for this 
statute. 

i. The value of this field will come from 
[tif_details_report].Affordable_Housing_Percent. 
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ii. The value will represent [property_exemption].exemption_percent for 

the exemption of the property( [property_exemption] ) where 
exemption_id is of [exemption_statute] where dor_statute_cd = 
‘196.1978’ for the relevant property. 

 

41. County_AH_Amount 
a. This field will display the county exemption amount under the DOR statute 

196.1978  for the property with the selected Tif Zone, year and roll correction 
report parameters.  

i. The value of this field will come from 
[tif_details_report].County_AH_Amount. 

ii. This value will actually represent the sum of 
[property_taxing_authority_exemption_val].granted_exemption_amt 
where exemption_id is one of [exemption_statute] where dor_statute_cd 
= ‘196.1978’ and levy_cd is [tax_area_year].county_levy_cd where 
tax_area_id is [property_tax_area].tax_area_id for the relevant property. 

42. School_AH_Amount 
a. This field will display the school exemption amount under the DOR statute 

196.1978  for the property with the selected Tif Zone, year and roll correction 
report parameters.  

i. The value of this field will come from 
[tif_details_report].School_AH_Amount. 

ii. This value will actually represent the sum of 
[property_taxing_authority_exemption_val].granted_exemption_amt 
where exemption_id is one of [exemption_statute] where dor_statute_cd 
= ‘196.1978’ and levy_cd is [tax_area_year].school_levy_cd where 
tax_area_id is [property_tax_area].tax_area_id for the relevant property. 

 

43. City_AH_Amount 
a. This field will display the city exemption amount under the DOR statute 

196.1978  for the property with the selected Tif Zone, year and roll correction 
report parameters.  

i. The value of this field will come from 
[tif_details_report].City_AH_Amount. 

ii. This value will actually represent 
[property_taxing_authority_exemption_val].granted_exemption_amt 
where exemption_id is of [exemption_statute] where dor_statute_cd = 
‘196.1978’ and levy_cd is [tax_area_year].municipal_levy_cd where 
tax_area_id is [property_tax_area].tax_area_id for the relevant property. 

44. Independent_AH_Amount 
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a. This field will display the Independent exemption amount under the DOR statute 

196.1978  for the property with the selected Tif Zone, year and roll correction 
report parameters.  

i. The value of this field will come from 
[tif_details_report].Independent_AH_Amount. 

ii. This value will represent the 
[property_taxing_authority_exemption_val].granted_exemption_amt 
where exemption_id is of [exemption_statute] where dor_statute_cd = 
‘196.1978’ and levy_cd is [tax_area_year]. Isd_levy_cd where tax_area_id 
is [property_tax_area].tax_area_id for the relevant property. 

 

 

TFS 42452 
Added fields to the Special Assessment detail dialogue 

The fields are for a user to record the hearing phone number, Trim Total Assessment Revenues, and 
Hearing information for the Special Assessment.  Broward will use this information on their trim notices 

 

TFS 42490 
Split Merge Review 

New User Rights 

 Split Merge Set System Reviews 
o The privileges available will be: 

 View 
 Modify 

 Split Merge Set Default Reviews 
o The privileges available will be: 

 View 
 Modify 

 Split Merge – Mark as Complete  
o Each review added above in Section 1.2.4 will have user rights associated with 

the review so that only users with the appropriate user right will be allowed to 
mark ‘Review as Complete’. The ‘Execute’ privilege will be available for the 
following reviews: 
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If the Execute privilege is not there, "Mark Complete" is disabled for the review after the split is processed. 
 

o  
 

Review Name 
Legal Description Review 
Condo Review 
Commercial Land Value Review 
Residential Land Value Review 
Ag Land Value Review 
Commercial Improvement Value Review 
Residential Improvement Value Review 
Ag Improvement Value Review 
Commercial Building Permits Review 
Residential Building Permits Review 
Ag Building Permits Review 
Taxes Paid Review 
 

 

System Configuration setting 

The user reaches this View from Home -> Tools -> System Configuration.  

 

 

 

Figure 1.3.1a – System Configuration (Ignore highlighted field above – used only for sample display) 
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The following changes will be made to the System Configuration: 

 

1. Display Additional Split Merge Review fields 
a. A new System configuration ‘Display Additional Split Merge fields’ will be added 

to the ‘Split / Merge’ section of the System Configuration View. 
b. The available options for this configuration setting are: 

i. True 
ii. False 

c. The ‘False’ selection will leave the existing Split / Merge Dialog Panels and 
Property View -> Legal Description Panel as is without any changes. The current 
functionality will continue. 

d. The ‘True’ selection will display the following additional fields in the Split / 
Merge Dialog Panels and Property View -> Legal Description Panel. 

 Split / Merge Dialog – General Setup Panel 
o Run in GIS 

 Split / Merge Dialog – Split Setup Panel (OR) Merge Setup Panel 
o Taxes Not Paid – T-Change 
o Taxes Not Paid – PACS-Change 

 Property View – Legal Description Panel 
o Legal Square Feet 
o GIS Legal Square Feet 
o Legal Acres / Square Feet Instrument Number 

2.  Revenue Collector’s Website 
a. A new System configuration ‘Revenue Collector’s Website’ will be added to the 

‘Split / Merge’ section of the System Configuration View.  
b. Every county’s Revenue Collector’s URL should be added as the value for this 

config entry. 
c. For example, Broward will have the following URL, where the highlighted portion 

will be replaced with the corresponding property’s Geo ID for every property 
during search: 

https://broward.county-
taxes.com/public/real_estate/parcels/*****/bills 
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Set System Reviews 
The user will reach this new dialog by going to PACS Menu > Tools > Split/Merge > Set System Reviews. 
The user must have the new “Split/Merge – Set System Reviews” privilege. 

 

The whole dialog will be read-only if the user doesn’t have the “Split/Merge – Set System Reviews” 
privilege. 

 

The Split Merge Reviews Paragraph will contain the following grid: 

 

A. Set System Reviews Availability Grid 
a. This grid will allow the user to select which reviews will be available to them and 

their Hierarchy Order.  
i. Only those reviews selected with this tool will be available to the users to 

select as Defaults reviews at the Split / Merge – Set Default Reviews 
dialog. 

b. This grid will be populated from the [split_merge_review_type] table. 
c. This grid will be sorted by Review Name by default, but will allow the user to sort 

by any column. 
d. The grid will have the following columns: 

i. Review Name 
1. This column will display the Name for the Split Merge Review 

Type. 
2. This column will not be editable. 
3. The data for this field will be from 

[split_merge_review_type].[name] corresponding to the Type ID. 
ii. Is Available  

1. This column will allow the user to indicate whether the Review 
Type is available for selection as a default review. 

2. This column will be editable. 
3. This column will use a Checkbox editor. 
4. This column will be checked by default. 
5. The data for this field will be stored in 

[split_merge_review_type].[available_for_default]. 
iii. Hierarchy Order  

1. This new option will allow the user to set the hierarchy for needed 
reviews on a split or merged property.  

2. This column will allow the user to indicate the Hierarchy Order for 
this Review Type. 

a. Multiple reviews can be set to the same hierarchy order 
(say Land and Improvement Reviews can be done in either 
order). 
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b. Reviews will not be available to be marked as completed 

until all reviews with a higher priority order set to be 
completed are checked as complete. 
Example –  

i. Improvement review is set to 1. 
ii. Exemption Review is set to 2.  

iii. The Exemption Review will not be available to be 
checked and marked as completed until the 
Improvement review has been marked complete. 

3. This column will be editable. 
4. This column will allow only numeric values. 
5. The data for this field will be stored in 

[split_merge_review_type].[hierarchy_order]. 
 

 

Set Defaults for Reviews 

The user will reach this new dialog by going to PACS Menu > Tools > Split/Merge > Set Default Reviews. 
The user must have the new “Split/Merge – Set Default Reviews” privilege. 

 

The whole dialog will be read-only if the user doesn’t have the “Split/Merge – Set Default Reviews” 
privilege. 

 

The Split Merge Default Reviews Paragraph will contain the following grid: 

 

A. Set Default Reviews for Primary Use Codes Grid 
a. This grid will allow the user to select which reviews should be set as defaults 

based on Primary Use Codes (Property Use Codes tied to DOR Use Codes).  
i. Those reviews set with this tool will be available to the users as selected 

by default on the Split / Merge Dialog –Reviews panel based on the 
Property Use Code of the property(s) involved in the Split or Merge. 

b. This grid will be populated from the 
[split_merge_review_type_property_use_assoc] table. 

c. The grid will have the following columns: 
i. Review Name 

1. This column will display the Name for the Split Merge Review 
Type. 

2. This column will not be editable. 
3. The grid will be sorted by Review Name by default. 
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4. The data for this field will be from 

[split_merge_review_type].[name] corresponding to the Type ID 
in [split_merge_review_type_property_use_assoc]. 
[split_merge_review_type_id]. 

 

ii. Primary Use Codes  
1. This column will allow the user to map Primary Use Codes for 

each Review Type. 
2. This column will be editable. 
3. This column will open a Code Chooser editor to select / unselect 

multiple Primary Use Codes for mapping. 
4. This field is not required. 
5. The data for this field will be stored in 

[split_merge_review_type_property_use_assoc].[property_use_c
d]. 

 

 

 

Modification to the Existing Split Merge when the System Configuration is set to use the 
Reivew 

 

The user can reach this dialog through any of the following: 

- Opening a Property View, clicking the Commands drop-down menu and clicking 
Split/Merge.  

- PACS > Activities > Split/Merge > New Split/Merge.  
- PACS > Activities > Split/Merge > Pending Split/Merge and clicking on the Details 

button. 
 

The existing ‘Taxes Paid’ checkbox will be moved to the Split Setup / Merge Setup panels. 

Split/Merge Panel 

The following new field will be added to the General Paragraph: 

 

A. Run in GIS 
a. This field will allow the user to indicate ‘Run in GIS’ flag. 
b. The checkbox will be added between the Split/Merge Type and the Change 

request Type fields. 
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c. The checkbox will be informational. This field will be invoked in the Deeds 

Process that will be discussed in future use cases. 
d. The checkbox will not be required. 
e. The data for this field will be stored in [split_merge].[run_in_gis]. 

 

Modifications to the Split Merge Setup Dialog 

The Parent Property Paragraph will contain the following additional fields: 

 

A. ‘Open Property in Revenue Collector’s website’ link 
a. This link when clicked will open the property in the Revenue Collector’s website 

database for the property being split using the following URL, where the 
highlighted portion will be replaced with the corresponding property’s Geo ID: 

https://broward.county-taxes.com/public/real_estate/parcels/494131-
06-1580/bills 

i. If the URL is not set in the [pacs_config] table for [szConfigName] = 
‘Revenue Collector’s website’, then the link will not be active to perform 
the search. 

 

b. When the ‘Taxes Paid Review’ is selected –   
i. This review will require the ability to launch the Revenue Collector’s 

website for each property in the Split/Merge from the property level. 
ii. For the review, the user will use this link to launch the Revenue 

Collector’s website and open the specific property as matched to the 
parcel number to verify if taxes are paid. 

iii. Since the system will not know what property to jump to on the Revenue 
Collectors website until the parent has been identified on a split, the 
existing Taxes Paid check box will be moved from the General Setup 
Panel to the Split Setup panel to perform the review and make an 
appropriate selection. 

 

B. Taxes Paid 
a. The current ‘Taxes Paid’ functionality will be modified into a radio button.  
b. This will allow the user to select whether to use the existing Taxes Paid 

functionality. 
c. When the Taxes Paid radio button area is selected, it will make the existing Taxes 

Paid checkbox available for selection. 
d. When selected the existing functionality shall be maintained. 
e. This will be the default option. 
f. The data for this field will be stored in [split_merge].[taxes_paid]. 
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C. Taxes Not Paid – T-Change 
a. A second ‘Taxes Not Paid – T-Change’ radio button will be added.  
b. The radio button, when selected will disable the existing Taxes Paid validation 

functionality and instead will allow the split or merge to process with all other 
validation currently applied. 

c. The system will set the Taxes Paid Review option as a review needed. 
d. The data for this field will be stored in [split_merge].[taxes_not_paid_t_change]. 

 

D. Taxes Not Paid – PAC-Change 
a. A second ‘Taxes Not Paid – PAC-Change’ radio button will be added.  
b. The radio button, when selected will disable the existing Taxes Paid validation 

functionality and instead will allow the split or merge to process with all other 
validation currently applied. 

c. The system will set the Taxes Paid Review option as a review needed. 
d. The data for this field will be stored in 

[split_merge].[taxes_not_paid_pac_change]. 
 

 

 

The Parent Property Paragraph will be modified as follows: 

 

A. Parent Properties Grid 
a. Link to Revenue Collector’s website 

1. This column will display the ‘Open Property’ link for every property that is 
listed in the parent properties grid. 

2. This link when clicked will open the property in the Revenue Collector’s 
website database for the property being merged, using the following 
URL, where the highlighted portion will be replaced with the 
corresponding property’s Geo ID: 

https://broward.county-
taxes.com/public/real_estate/parcels/494131-06-1580/bills 

i. If the URL is not set in the [pacs_config] table for [szConfigName] 
= ‘Revenue Collector’s website’, then the link will not be active to 
perform the search. 

3. This column will not be editable.  
4. When the ‘Taxes Paid Review’ is selected –   
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i. This review will require the ability to launch the Revenue 

Collector’s website for each property in the Split/Merge from the 
property level. 

ii. For the review, the user will use this link to launch the Revenue 
Collector’s website and open the specific property as matched to 
the parcel number to verify if taxes are paid. 

 

B. Taxes Paid 
a. The existing Taxes Paid check box will be moved from the General Setup Panel to 

the Merge Setup panel. 
b. The current ‘Taxes Paid’ functionality will be modified into a radio button.  
c. This will allow the user to select whether to use the existing Taxes Paid 

functionality. 
d. When the Taxes Paid radio button area is selected, it will make the existing Taxes 

Paid checkbox available for selection. 
e. When selected the existing functionality shall be maintained. 
f. This will be the default option. 
g. The data for this field will be stored in [split_merge].[taxes_paid]. 

 

C. Taxes Not Paid – T-Change 
a. A second ‘Taxes Not Paid – T-Change’ radio button will be added.  
b. The radio button, when selected will disable the existing Taxes Paid validation 

functionality and instead will allow the split or merge to process with all other 
validation currently applied. 

c. The system will set the Taxes Paid Review option as a review needed. 
d. The data for this field will be stored in [split_merge].[taxes_not_paid_t_change]. 

 

D. Taxes Not Paid – PAC-Change 
a. A second ‘Taxes Not Paid – PAC-Change’ radio button will be added.  
b. The radio button, when selected will disable the existing Taxes Paid validation 

functionality and instead will allow the split or merge to process with all other 
validation currently applied. 

c. The system will set the Taxes Paid Review option as a review needed. 
d. The data for this field will be stored in 

[split_merge].[taxes_not_paid_pac_change]. 
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The Reviews Paragraph will include the following changes: 

 

A. Reviews Grid 
a. The following reviews currently exist: 

i. Land Value Review 
ii. Improvement Value Review 

iii. Commercial Value Review 
iv. Exemptions Review 
v. Ownership Review 

vi. Ag Review 
vii. Income Valuation Review 

viii. Building Permits Review 
ix. GIS Review 
x. TIF Review  

xi. Situs Review 
b. The following reviews will be added to the dialog: 

i. Legal Description Review 
ii. Condo Review 

iii. Commercial Land Value Review 
iv. Residential Land Value Review 
v. Ag Land Value Review 

vi. Commercial Improvement Value Review 
vii. Residential Improvement Value Review 

viii. Ag Improvement Value Review 
ix. Commercial Building Permits Review 
x. Residential Building Permits Review 

xi. Ag Building Permits Review 
xii. Taxes Paid Review 

1. This review will require the ability to launch the Revenue 
Collector’s website for each property in the Split/Merge from the 
property level. 

2. This command shall launch to the Revenue Collector’s website 
and open the specific property as matched to the parcel number, 
using the following URL, where the highlighted portion will be 
replaced with the corresponding property’s Geo ID: 
https://broward.county-
taxes.com/public/real_estate/parcels/494131-06-1580/bills  

3. The user will ensure the taxes have been paid and set the Taxes 
paid review as complete. 

c. All reviews added here will have the same functionality as the existing reviews 
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i. Additional functionality will be added to allow completing Reviews based 

on the new hierarchy order as mentioned in Section 1.3.1 – Split / Merge 
– Set System Reviews Dialog. 

d. The reviews that the user set as defaults (defined in Section 1.3.2 – Split / Merge 
– Set Default Reviews Dialog) for the Primary Use Codes, will be displayed as 
automatically selected in this grid, based on the Property Use Code(s) of the 
selected Parent Property(s). 

e. The defaults will be editable in the Reviews Grid and can selected/unselected for 
each new Split/Merge. 
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There will now be a mechanism to list all the Split/Merge Properties that require a review and be 
allowed to complete the review from this list. 
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The user will reach this new dialog by going to PACS > Activities > Split/Merge > Split/Merge Review. 

 

The ‘Mark Complete’ button functionality in the Search Results Paragraph will be modified as follows: 

 

A. Search Results Grid 
a. Mark Complete 

i. This button will be disabled if the user doesn’t have the review type specific 
privilege for the selected row. 

1. Each review will have user rights associated with the review so that 
only users with the appropriate user right will be allowed to mark a 
review as complete. 

ii. This button will be disabled if the selected row has a lower hierarchy order. 
1. Reviews will not be available to be marked as completed until all 

reviews with a higher priority order set to be completed are checked 
as complete 

a. Example – Improvement review is set to 1 
b. Exemption Review is set to 2 
c. The Exemption Review will not be available to be checked and 

marked as completed until the Improvement review has been 
marked complete. 

d. The hierarchy order will be based on the value set in 
[split_merge_review_type]. 
[hierarchy_order]. 
 

b. The grid will have the following additional column: 
i. Hierarchy Order 

a. This column will display the Review Type Hierarchy Order. 
b. This column will be read-only. 
c. The data for this field will come from 

[split_merge_review_type].[hierarchy_order]. 
 

 

  



46 
 

An user can list all the reviews for a single property: 

The user will reach this new dialog by opening a Property and going to Commands > Split/Merge Review. 
This dialog will be shown modal to the Property View. The user must have the new “Property 
Split/Merge – View” privilege. 

 
The ‘Mark Complete’ button functionality in the Search Results Paragraph will be modified as follows: 

 

A. Reviews Grid 
c. Mark Complete 

i. This button will be disabled if the user doesn’t have the review type specific 
privilege for the selected row. 

1. Each review will have user rights associated with the review so that 
only users with the appropriate user right will be allowed to mark a 
review as complete. 

ii. This button will be disabled if the selected row has a lower hierarchy order. 
1. Reviews will not be available to be marked as completed until all 

reviews with a higher priority order set to be completed are checked 
as complete 

a. Example – Improvement review is set to 1 
b. Exemption Review is set to 2. 
c. The Exemption Review will not be available to be checked and 

marked as completed until the Improvement review has been 
marked complete. 

d. The hierarchy order will be based on the value set in 
[split_merge_review_type]. 
[hierarchy_order]. 

 

d. The grid will have the following additional column: 
ii. Hierarchy Order 

a. This column will display the Review Type Hierarchy Order. 
b. This column will be read-only. 
c. The data for this field will come from 

[split_merge_review_type].[hierarchy_order]. 
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With all the new features there will also be added fields to the property view 

 

 

 

- The user reaches here by opening a Property and expanding the Legal Description Panel. 

- The new system configuration defined in Section 1.3.0 will enable / disable these fields on the UI. 

- The same user rights that control the Legal Description view will be used to allow edits to these new 
fields. 

 

The Abstract/Subdivision Paragraph will have the following additional field: 

 

A. Legal Acre / Sq. Ft. Instrument Number 
a. This new textbox will be added to the right of the existing Page field. 
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b. The field will not be required. 
c. This column will be varchar(50). 
d. The data for this field will be stored in 

[property_val].[legal_acre_sqft_instrument_number]. 
 

 

The existing Area & Percentages Paragraph will have the following additional fields: 

 

A. Legal Square Feet 
a. This new textbox will be added directly below the existing Legal Acres field. 
b. The field will not be required. 
c. This column will be numeric(14, 2). 
d. The data for this field will be stored in [property_val].[legal_square_feet]. 
e. The Legal Square Feet field will be added as an attribute available in the GIS 

viewer in the parcel layer with the potential to display it as a label. 
 

B. GIS Legal Square Feet 
a. This new textbox will be added next to the new Legal Square Feet field above. 
b. The field will not be required. 
c. This column will be numeric(14, 2). 
d. The data for this field will be stored in [property_val].[gis_legal_square_feet]. 
e. Field will be populated from the parcel layer GIS view. 
f. The field will be added to the GIS parcel layer view so that the GIS department 

can populate the view. 
g. The GIS Legal Square Feet field will be added as an attribute available in the GIS 

viewer in the parcel layer with the potential to display it as a label. 
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TFS  42572 
 

Import State Assessed Property 

Import Run View 

Menu Option: PACS Menu  Import  State Assessed Properties  

Security Right: Import  Import Create Properties (Execute) *Note: This is an existing user right. 

 

 Columns: 
o Run ID 

 Data Binding: [import_properties_run].[import_properties_run_id] 
 Format: Integer, no commas, left aligned 

o Import Date 
 Data Binding: [import_properties_run].[import_date] 
 Format: Date, centered 

o Import User 
 Data Binding: [import_properties_run].[import_user_id]  

[pacs_user].[pacs_user_name] 
 Format: String, left aligned 

o Year 
 Data Binding: [import_properties_run].[state_assessed_year] 
 Format: Date, centered 

o # of Properties in File 
 Data Binding: [import_properties_run].[record_count] 
 Format: Integer, no commas, right aligned 

o # Updated 
 Data Binding: [import_properties_run].[record_count] 
 Format: Integer, right aligned 

o # Deleted 
 Data Binding: [import_properties_run].[deleted_properties_count] 
 Format: Integer, right aligned 

o # Not Matched 
 Data Binding: [import_properties_run].[invalid_properties_count] 
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 Format: Integer, right aligned 

o # Created 
 Data Binding: [import_properties_run].[created_properties_count] 
 Format: Integer, right aligned 

o Processed Date 
 Data Binding: [import_properties_run].[processed_date] 
 Format: Date, centered 

o Processed User 
 Data Binding: [import_properties_run].[processed_by_id]  

[pacs_user].[pacs_user_name] 
 Format: String, left aligned 

 Tool Strip Commands 
o ‘+’ (Add Button) – Invokes the dialog described in Section Error! Reference 

source not found. to create a new import run. 
o ‘x’ (Delete Button) 

 Only enabled for runs that have not been processed 
([import_properties_run].[status] = ‘I’) 

 If clicked, the user is prompted with a confirmation dialog stating, “Are 
you sure you want to delete the selected run?” 

o Process Button – Invokes the dialog discussed in Section Error! Reference source 
not found. to process the selected run. 

 Only enabled for runs that have not been processed 
([import_properties_run].[status] = ‘I’) 

 If clicked, the user is prompted with a confirmation dialog stating, “Are 
you sure you want to process the selected run?” 

o View Unmatched – Invokes the dialog discussed in Section Error! Reference 
source not found. to process the selected run. 

 Only enabled for runs that have been processed 
([import_properties_run].[status] = ‘P’) and where “# Not Matched” is 
non-zero. 
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Import 

Menu Option: Click ‘+’ icon from Import Runs View grid tool strip. 

 

The dialog will contain the following elements: 

 Import File Path – A file chooser allowing the user to select a file to import. 
o Required. 
o The file must be located in a valid network path (the path must begin with “\\”).  

If a local file is selected, then a validation message informing the user that the 
file must be located on a network path will be displayed. 

o Data Binding: [import_properties_run].[file_path] 
 

If the user clicks the “Import” button, and all options are valid, the application will perform the following 
import process steps: 

1. A new record will be added to the [import_properties_run] table with the following field 
values: 
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2.  
 

Field Name Value 
import_properties_run_id auto-incrementing record ID 
status  “I” 
import_date The current date and time 
import_user_id The ID of the currently logged in PACS user from the 

[pacs_user] table. 
record_count The number of records read from the import file. 
valid_properties_count NULL 
invalid_properties_count NULL 
processed_date NULL 
processed_by_id NULL 
file_path {user selection from the dialog options} 
in_current_year 1 
in_future_year 0 
state_assessed_year year read from the import file 
deleted_properties_count NULL 
created_properties_count NULL 

 
3. The file format of the import file must be an Excel  workbook (XLSX) file defined 

according the format previously specified by the definition in Section Error! Reference 
source not found. where each row represents a record with the following data.  As each 
row is read from the file, a new record will be added to the 
[import_properties_run_record] table, mapping the following elements to the fields 
documented below: 
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Menu Option: Click ‘Process’ button from Import Runs View grid tool strip. 

 

When the user clicks the “Process” button on the Import Runs view grid tool strip, the application will 
perform the following steps: 

 

1. Validate whether or not the current year specified be 
[import_properties_run].[state_assessed_year] has been certified.  If so, present a 
validation error and do not continue. 
 

Attempt to match the imported records to an existing property in PACS 
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For each record in the [import_properties_run_record] table, if exactly 1 match is found, then 
the [parcel_id] and [prop_type_cd] will be updated in the [import_properties_run_record] table 
record. 

2. A second query similar to the SQL in Step 2 will be run, with difference being that 
inactive properties will be excluded in the data being searched, to determine if a match 
to a single active property can be found:  

3. A third query similar to the SQL in Step 3 will be run, with difference being that if 
multiple records exist matching the FEIN and Tax Area, the application will update the 
[import_properties_run_record].[parcel_id] with the first (minimum) prop_id found. 

4. The remaining properties in the [import_properties_run_record] table where parcel_id 
is blank and error_message has not been set will have their [error_message] set to the 
value ‘No property found for the FEIN, Tax Area, and Property Type specified.’ 

5. The following fields in the [import_properties_run] will be updated for the run: 
Field Name Value 
valid_properties_count Count of records in the run where parcel_id is not blank. 
invalid_properties_count Count of records in the run where parcel_id is blank. 
processed_date The current date and time 
processed_by_id The ID of the currently logged in PACS user from the 

[pacs_user] table. 
6. For each record in the [import_properties_run_record] table where parcel_id is not 

blank, the information in the record will be used to update field values for those 
properties that exist in the uncertified year layer 

 

Unmatched Properties 

Menu Option: Click ‘View Unmatched’ button from Import Runs View grid tool strip. 

 

When the user clicks the “View Unmatched” button on the Import Runs view grid tool strip, the 
application will display a child dialog similar to the following mockup, showing records from the 
[import_properties_run_record] table for the run where parcel_id is blank 
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 Columns: 
o File Line # 

 Data Binding: [import_properties_run_record].[line_number] 
 Format: Integer, no commas, left aligned 

o FEI Number 
 Data Binding: 

[import_properties_run_record].[federal_employee_identification_numb
er] 

 Format: Integer, no commas, left aligned 
o Name 

 Data Binding: [import_properties_run_record].[business_name] 
 Format: String, left aligned 

o Address Line 1 
 Data Binding: [import_properties_run_record].[addr_line1] 
 Format: String, left aligned 

o Address Line 2 
 Data Binding: [import_properties_run_record].[addr_line2] 
 Format: String, left aligned 

o City 
 Data Binding: [import_properties_run_record].[addr_city] 
 Format: String, left aligned 

o State 
 Data Binding: [import_properties_run_record].[addr_state] 
 Format: String, left aligned 
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o Zip 
 Data Binding: [import_properties_run_record].[zip] 
 Format: Integer, no commas, left aligned 

o Tax Area 
 Data Binding: [import_properties_run_record].[tax_area_number] 
 Format: String, left aligned 

o Error Message 
 Data Binding: [import_properties_run_record].[error_message] 
 Format: String, left aligned 

 
 Tool Strip Commands 

o “Create New Accounts” Button – Invokes the process discussed in Section 4.6 to 
process the selected run. 

 Only enabled for runs that have not been processed 
([import_properties_run].[status] = ‘I’) 

 If clicked, the user is prompted with a confirmation dialog stating, “Are 
you sure you want to process the selected run?” 

 

Create New Accounts 

Menu Option: Click ‘Create New Accounts’ button from View Unmatched Properties Dialog grid tool 
strip. 

 

When the user clicks the button, the application will present the following dialog: 
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The dialog will contain the following input elements: 

 Create New Accounts Options 
o If the “Do not create new Taxpayer records…” option is selected, then only Step 

1 of the process described below will be performed. 
o If the “Create new Taxpayer records…” option is selected, then both Step 1 and 

Step 2 of the process described below will be performed. 
 

 Geo ID Options 
o If the “Leave Geo ID blank…” option is selected, then the Geo ID of any new 

property records create by either Step 1 or Step 2 of the process described 
below will be left blank. 

 The Sequence # textbox will be cleared and disabled. 
 The Apply Custom Formatting checkbox will be cleared and disabled. 
 The Custom formatting textbox will be cleared and disabled. 
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o If the “Build Geo ID…” option is selected, then the Geo ID of any new property 

records create by either Step 1 or Step 2 of the process described below will be 
populated using the parameter specified by the user. 

 The Sequence # textbox will be enabled, and become required.  It will 
allow only a numeric value to be entered up to 9 characters. 

 The “Apply custom formatting” checkbox will become enabled. 
 If checked, the custom formatting textbox will become enabled 

and required.  The user may enter any pattern they choice up to 
50 characters.  Any ‘#’ characters in the string will be replaced by 
digits from the sequence number specified by the user.* 

 If unchecked, the custom formatting textbox will become disabled 
and cleared. 

It both a sequence # and a custom format have been provided by the user, then 
validation will scan the custom formatting string for ‘#’ characters and display a 
validation error if not greater than or equal to the number of digits in the 
sequence number. 

 
 If the user clicks “Cancel”, then the dialog is dismissed with no further action take. 

 
If the user clicks “OK”, then the dialog is dismissed and the process described below will be executed 
depending on the user’s input 

 

For each record where a prop_id was matched, the application will perform the following additional 
steps: 

 

1. Create a new property record in PACS with a new [prop_id], and set the [geo_id] 
according to the following process. 

a. If the “Leave Geo ID blank…” option was selected from the dialog, then leave the 
geo_id blank and exit these sub-steps. 

b. If the “Build Geo ID…” option was selected from the dialog, the sub-process 
should be keeping track of an integer sequence # that is incremented after each 
execution of this “Build Geo ID” process. 

i. If the “Apply custom formatting” option is not selected 
1. Convert the current sequence number into a string. 
2. Assign the string to the property.geo_id. 
3. Increment the sequence number for the next property created. 

ii. If the “Apply custom formatting” option is selected, 
1. Convert the current sequence number into a string. 
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2. Count the number of ‘#’ characters in the format string, and if 

necessary, prepend “0” characters to the string version of the 
sequence number until its string length matches the count. 

3. Iterate through the characters of the custom format one 
character at a time.  If the character in not a ‘#’ character, append 
it to the property.geo_id, otherwise append the next unused digit 
from the left of the string sequence # to the property.geo_id.  

4. Increment the sequence number for the next property created. 
 

2. Update the [import_properties_run_record].[parcel_id] with the new prop_id. 
 

3. Create a new owner record in the uncertified year layer using the new prop_id and 
acct_id as owner_id from the value returned in the query above. Set primary_owner = 1. 
 

4. Create a property_tax_area record in the uncertified year layer using the new prop_id 
and tax area information from the value returned in the query above.  
 

5. Create a property_val record in the uncertified year layer using the new prop_id that is 
otherwise a duplicate of the property_val record of the prop_id being copied. 
 

6. Update the new property_val record using the values from the query above. 
 

7. Update the address record where primary_addr = ‘Y’ using the address information 
associated with the account in the [import_properties_run_record] record being 
processed. 
 

8. Update the [error_message] field of the [import_properties_run_record] record being 
processed to read “Unmatched property created for new Tax Area ‘{Tax Area}’ using 
Prop ID ‘{Copied Prop ID}’ from Tax Area ‘{Old Tax Area}’”, and update the [parcel_id] 
field to the newly created prop_id. 
 

9. Update the [import_properties_run].[created_properties_count] to the count of the 
number of properties created using this process.   
 

10. Update the [import_properties_run].[invalid_properties_count] to the count of the 
number of properties whose parcel_id is still blank.   
 

11. Update the [import_properties_run].[valid_properties_count] to the count of the 
number of properties whose parcel_id is not blank. 
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If the user selected the “Create new taxpayer records…” option in the dialog above, the application will 
perform additional steps to iterate through each record in the [import_properties_run_record] table for 
the selected Run ID where parcel_id is still blank and perform the following additional steps: 

 

1. Create a new [account] record with a new acct_id and set the following field values from 
the import record: 
 

[account] Field Name Import Record Field Name Notes 
acct_id -- Auto-

generate
d by 
PACS 

file_as_name business_name  
acct_create_dt -- Current 

date and 
time 

source -- ‘DOR 
Import’ 

update_dt -- Current 
date and 
time 

taxpayer_type_cd  ‘B’ 
(Busines
s) 

business_name business_name  
federal_employer_identification_nu
mber 

federal_employer_identification_nu
mber 

 

   
 

1. Create a new property record in PACS with a new [prop_id], and set the [geo_id] 
according to the following process. 

a. If the “Leave Geo ID blank…” option was selected from the dialog, then leave the 
geo_id blank and exit these sub-steps. 

b. If the “Build Geo ID…” option was selected from the dialog, the sub-process 
should be keeping track of an integer sequence # that is incremented after each 
execution of this “Build Geo ID” process. 

i. If the “Apply custom formatting” option is not selected 
1. Convert the current sequence number into a string. 
2. Assign the string to the property.geo_id. 
3. Increment the sequence number for the next property created. 

ii. If the “Apply custom formatting” option is selected, 
1. Convert the current sequence number into a string. 
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2. Count the number of ‘#’ characters in the format string, and if 

necessary, prepend “0” characters to the string version of the 
sequence number until its string length matches the count. 

3. Iterate through the characters of the custom format one 
character at a time.  If the character in not a ‘#’ character, append 
it to the property.geo_id, otherwise append the next unused digit 
from the left of the string sequence # to the property.geo_id.  

4. Increment the sequence number for the next property created. 
 

2. Update the [import_properties_run_record].[parcel_id] with the new prop_id. 
 

3. Create a new owner record in the uncertified year layer using the new prop_id and 
acct_id as owner_id from the value returned in the query above. 
 

4. Create a property_tax_area record in the uncertified year layer using the new prop_id 
and tax area information from the value returned in the query above.  
 

5. Create a property_val record in the uncertified year layer using the new prop_id that is 
otherwise a duplicate of the property_val record of the prop_id being copied. 
 

6. Update the new property_val record using the values from the query above. 
 

7. Update the address record where primary_addr = ‘Y’ using the address information 
associated with the account in the [import_properties_run_record] record being 
processed. 
 

8. Update the [error_message] field of the [import_properties_run_record] record being 
processed to read “Unmatched property created for new Tax Area ‘{Tax Area}’ using 
Prop ID ‘{Copied Prop ID}’ from Tax Area ‘{Old Tax Area}’”, and update the [parcel_id] 
field to the newly created prop_id. 
 

9. Update the [import_properties_run].[created_properties_count] to the count of the 
number of properties created using this process.   
 

10. Update the [import_properties_run].[invalid_properties_count] to the count of the 
number of properties whose parcel_id is still blank (it should be zero at this point).   
 

11. Update the [import_properties_run].[valid_properties_count] to the count of the 
number of properties whose parcel_id is not blank. 
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State Assessed Property by Owner Report 

Menu Option: PACS Menu  Reports  State Assessed by Owner  

The dialog will contain a grid with the following options: 

 

 Year – List years from the pacs_year table 
o Includes future year 
o Lists years in reverse descending order (most current year at the top) 
o Defaults to the most current year   

 
 As Of – Selection of the year state for which to run the report in the selected year.  If 

the future year is selected, this paragraph will be disabled. 
 

 Property Sub-type – A code chooser allowing the user to choose one or more property 
sub-type codes. 

o Default value is “<All>”. 
 

The report dialog will present the standard output options, but will be customized to utilize the new 
Excel document generation functionality only.  The “Format” option will be set to “Excel” and disabled.  

 

 The Excel output will be a straight dump of the columns output by the 
SelectStateAssessedPropertyListReportData stored procedure described in Section 
Error! Reference source not found. without embellishment. 
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TFS 43132 
Group  by for TPP segments and Sub Segments 

Open a TPP property and go to personal property.  Right click on a sub segment column heading and 
choose the Show Group by Box 

 

 

 

The user should be able to drag a column heading into the green area and have the subsegments 
grouped by the column heading.  
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Enable the Group By This Column 
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TFS 43147 
 

Add Waterfront Footage 

 

Waterfront Footage is added to the search capabilities 
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Waterfront Footage (Minimum) 

a. This field will be used to enter the ‘Minimum’ / ‘From’ value for Waterfront Footage. 
b. The field is not required and will be blank by default. 
c. This value should be greater than zero and (less than or equal to) the Maximum 

Waterfront Footage. 
d. If the Minimum field is blank, the system will search for all sizes up to and equal to 

the Maximum field. 
e. This column will be numeric(18,2). 
f. The search criteria will be on [land_detail].[waterfront_footage]. 

 

Waterfront Footage (Maximum) 

a. This field will be used to enter the ‘Maximum’ / ‘To’ value for Waterfront Footage. 
b. The field is not required and will be blank by default. 
c. This value should be greater than zero and (greater than or equal to) the Minimum 

Waterfront Footage. 
d. If the Maximum field is blank, the system will search for all sizes less than or equal to 

the Minimum field. 
e. This column will be numeric(18,2). 
f. The search criteria will be on [land_detail].[waterfront_footage]. 

 

 

If both these values are not entered, this search criteria will not be considered (existing functionality). 
Along with any other entered criteria, the system will select all properties with a total Waterfront 
footage (of all land details) that are within the search parameters entered as other existing range 
searches. 
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Added to the Mass Update  

 

The Land / Improvement Detail Level Paragraph will have the following additional fields as a new search 
criteria: 

 

A. Waterfront Footage (Minimum) 
a. This field will be used to enter the ‘Minimum’ / ‘From’ value for Waterfront 

Footage. 
b. The field is not required and will be blank by default. 
c. This value should be greater than zero and (less than or equal to) the Maximum 

Waterfront Footage. 
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d. If the Minimum field is blank, the system will search for all sizes up to and equal 

to the Maximum field. 
 

B. Waterfront Footage (Maximum) 
a. This field will be used to enter the ‘Maximum’ / ‘To’ value for Waterfront 

Footage. 
b. The field is not required and will be blank by default. 
c. This value should be greater than zero and (greater than or equal to) the 

Minimum Waterfront Footage. 
d. If the Maximum field is blank, the system will search for all sizes less than or 

equal to the Minimum field. 
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TFS 42638 
 

Ag Use Export  

Export>Ag use 

The dialog will have the following: 

 

1. Year 
a. This field will be the year used for the export data. 
b. This field will be read-only. 
c. This field will be auto-populated by the current assessment year. 

2. Ag Use Codes 
a. This field will allow the user to filter the export by Land Ag Use codes. 
b. This field will allow multiple selection through a checked combo box. 
c. This field will filter the exported records through [land_detail].ag_use_cd. 

3. Export 
a. Clicking this button will validate input and begin the export process. 

i. The export file will be created in the default Export location and will show 
up in the Inbox. 

ii. Export is tab delimited 
Description Max lentgth 
Prop ID 10 
Geo ID 50 
File As Name 266 
Address Line 1 60 
Address Line 2 60 
Address Line 3 60 
Address City 50 
Address State 50 
Address Country 5 
Address Zip 10 
Legal Description 255 
Situs 173 
Land Use Code #1 10 
Land Acres #1 18,4 – size in acres of first land detail with ag and , acres 
  
Land Use Code #10 10 
Land Acres #10 18,4 - size in acres of 10yh land detail with ag and , acres 
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New Ag Panel 

Controlled by the system configuration at Tools> System Configuration>System>Land> Enable Ag Info 

Set this to True for the new ag info panel 

 

The panel will have the following paragraphs: 

 

1. <Current Year> Ag Status 
a. This paragraph will have Ag Status information for the year opened in the 

Property View. 
i. The year will be displayed in the header as shown in the wireframe. 

ii. The paragraph will be editable only if the Property year is uncertified or is 
in a roll correction. 

b. The paragraph will contain the following fields: 
i. Ag Status 

1. This field will allow the user to select an Ag Status Code. 
2. This field will be stored in [property_ag_info].ag_status_cd. 

ii. Granted Acres 
1. This field will display the Ag granted acres. 
2. This field will be read-only. 
3. This field will be calculated by the Recalc engine. 
4. This field will be stored in [property_ag_info].granted_acres. 
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iii. Acres not in Ag 

1. This field will display the Ag granted acres. 
2. This field will be read-only. 
3. This field will be calculated by the Recalc engine. 
4. This field will be formatted like this: #,##0.00. 
5. This field will be stored in [property_ag_info].granted_acres. 

iv. Acres not in Ag Reason 
1. This field will display the acres not in Ag. 
2. This field will be read-only. 
3. This field will be calculated by the Recalc engine. 
4. This field will be formatted like this: #,##0.00. 
5. This field will be stored in [property_ag_info].not_granted_acres. 

v. VAB 
1. This field will allow the user to select an Ag VAB Code. 
2. This field will be stored in [property_ag_info].ag_vab_cd. 
3. When this field is changed, the VAB Ag Granted indicator will be 

refreshed. 
a. If the Ag Granted Year override is not set, the following 

process will be used: 
i. Starting with the Current Assessment Year and 

going backwards to the last year in the system for 
this Property, find the first year where the VAB 
field is set to an Ag VAB Code with the Granted 
flag. 

1. Look at the [property_ag_info].ag_vab_cd 
field, and check that [ag_vab].granted = 1. 

ii. If a year is found in (i), then set 
[property].ag_granted_year to that year. 

iii. Otherwise set [property].ag_granted_year to NULL. 
b. If the override is set, nothing will change. 

vi. VAB Granted Acres 
1. This field will allow the user to enter the VAB Ag granted acres. 
2. This field will be formatted like this: #,##0.00. 
3. This field will be stored in [property_ag_info].vab_granted_acres. 

vii. VAB Acres not in Ag 
1. This field will allow the user to enter the VAB acres not in Ag. 
2. This field will be formatted like this: #,##0.00. 
3. This field will be stored in 

[property_ag_info].vab_not_granted_acres. 
 

2. <Prior Year> Ag Status 
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a. This paragraph will have Ag Status information for one year prior to the one 

opened in the Property View. 
i. The year will be displayed in the header as shown in the wireframe. 

ii. The paragraph will be editable only if the Property year is uncertified or is 
in a roll correction. 

b. The paragraph will contain the same fields described for the current year 
paragraph. 

c. History 
i. This button will allow the user to see history about the Ag Status fields. 

ii. Clicking this button will open the Ag Status History Dialog. 
iii. History will be recorded in the following way: 

1. When the Property record is saved, if any of the following fields 
changed (including the <Prior Year> Ag Status paragraph): 

a. Ag Status 
b. Granted Acres 
c. Acres not in Ag 
d. Acres not in Ag Reason 
e. VAB 
f. VAB Granted Acres 
g. VAB Acres not in Ag 
h. New App Recv 
i. Ag Green Card 

2. Then a new record will be inserted into the 
[property_ag_status_history] table. 

a. year = Property Year Layer where change is made 
b. prop_id = Current Property Id 
c. changed_date = Current Date/Time 
d. changed_by_user_id = Current Active User 
e. The rest of the fields in that table will be set to the current 

values of those same fields in the [property_ag_info] table. 
3. Mailings 

a. This paragraph will have the following fields: 
i. New App Recv 

1. This field will allow the user to enter or select a date. 
2. This field will not be required. 
3. This field will be stored in 

[property_ag_info].new_app_received_date. 
ii. Ag Green Card 

1. This field will allow the user to select whether an Ag Green Card 
was scanned. 

2. This field will be a dropdown of the following values: 
a. Yes 
b. No (this will be the default value) 
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3. This field will be stored in 
[property_ag_info].green_card_scanned. 

iii. Letter Sent 
1. This field will allow selection of the Ag Letter Codes. 
2. This field will not be required. 
3. This field will be stored in [property_ag_info].ag_letter_cd. 

iv. Letter Date 
1. This field will allow the user to enter or select a date. 
2. This field will not be required. 
3. This field will be stored in [property_ag_info].ag_letter_date. 

v. Response 
1. This field will allow selection of the Ag Response Codes. 
2. This field will not be required. 
3. This field will be stored in [property_ag_info].ag_response_cd. 

vi. Response Date 
1. This field will allow the user to enter or select a date. 
2. This field will not be required. 
3. This field will be stored in [property_ag_info].ag_response_date. 

vii. History 
1. This button will allow the user to see history about the Response 

Date field. 
2. Clicking this button will open the Ag Response History Dialog. 
3. History will be recorded in the following way: 

a. When the Property record is saved, if the Response Date 
field changed: 

b. Then a new record will be inserted into the 
[property_ag_response_history] table. 

i. year = Property Year Layer that is open 
ii. prop_id = Current Property Id 

iii. changed_date = Current Date/Time 
iv. changed_by_user_id = Current Active User 
v. ag_response_date = 

[property_ag_info].ag_response_date. 
 

4. Granted 
a. This paragraph will only be visible if [property].ag_granted_year is not null. 
b. In addition to (a), this paragraph’s visibility will be controlled by a configuration. 
c. This paragraph will have the following fields: 

i. Ag Granted Year 
1. This field will display the year ag was granted by the VAB. 
2. This field will be read-only by default. 
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3. When enabled, it will be a drop-down and will allow selection 

from all the years in the system (including the Future Year if 
available).  

4. This field will be stored in [property].ag_granted_year. 
5. This field will have an override check box. 

a. The override checkbox will only be enabled for users with 
the Modify VAB Ag Granted privilege. 

b. When checked, the Ag Granted Year field will become 
enabled. 

c. The override will be stored in 
[property].ag_granted_year_override. 

d. If the override get unchecked, the calculation process for 
the Ag Granted Year will be performed. 

 

Ag Inspection Panel 

This panel is also controlled by the Ag configuration mentioned above in Ag Info Panel 
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The panel will have the following paragraphs: 

 

1. Inspection Information 
a. The new paragraph will have the following fields: 

i. Inspected By 
1. This field will allow the user to select an Appraiser. 
2. This field will be a drop down of all active Appraisers. 

a. This will be populated from the [appraiser] table where 
inactive = ‘F’ 

3. This field will not be required.  
4. This field will be stored in [property_ag_info].inspected_by_id. 
5. When the Property record is saved, if this field has changed then a 

new record in [property_ag_inspection_history] will be created. 
a. inspected_by = value of this field 
b. inspected_date = value of the Inspected Date field 

ii. Inspected Date 
1. This field will allow the user to enter or select a date. 
2. This field will not be required. 
3. This field will be stored in [property_ag_info].inspected_date. 
4. When the Property record is saved, if this field has changed then 

the same process of recording history as the Inspected By field 
will be performed. 

iii. Reviewed All 4 Corners 
1. This field will allow the user to select whether the appraiser 

reviewed all 4 corners. 
2. This field will be a dropdown of the following values: 

a. <Empty> (this will be the default value) 
b. Yes 
c. No  

3. This field will be stored in 
[property_ag_info].inspection_4_corners_reviewed. 

iv. Access 
1. This field will allow selection of the Ag Access Codes. 
2. This field will not be required. 
3. This field will be stored in [property_ag_info].ag_access_cd. 

 

2. Prior Inspection 
a. The new paragraph will have the following: 

i. Inspections Grid 
1. This grid will display prior inspections for this Property. 
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a. This grid will display rows from 

[property_ag_inspection_history] where prop_id is the 
current property id. 

b. This grid will have a tool strip with the following buttons: 
i. Delete 

1. This button will delete the focused row 
from the grid. 

2. Confirmation will be asked prior to deleting 
the row. 

3. “Are you sure you want to delete the 
selected inspection?” 

 

3. Review Status 
a. This new paragraph will have the following: 

i. Status 
1. This field will allow selection of the Ag Review Status Codes. 
2. This field will not be required. 
3. This field will be stored in 

[property_ag_info].ag_review_status_cd. 
ii. Last Status Changed By 

1. This field will display the user name and date of the last change of 
the Review Status field. 

2. This field will be stored in 
[property_ag_info].ag_review_status_changed_by_id (but will 
display [pacs_user].pacs_user_name) and 
[property_ag_info].ag_review_status_changed_date. 

 

4. Notes 
a. This new paragraph will have the following: 

i. Notes Grid 
1. This grid will allow the user to view and enter notes for the 

Property year that is open. 
a. This grid will display rows from [property_ag_log] where 

type = ‘N’, prop_id is the current property Id and year is 
the current property year. 

2. This grid will have a tool strip with the following buttons: 
a. New 

i. This button will create a new row at the top of the 
grid. 

ii. The new row will have an empty note but will fill 
the Date and User fields with the current date and 
the active user name. 
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1. [property_ag_log].changed_date = Current 

Date 
2. [property_ag_log].changed_by_user_id = 

Active User Id 
3. [property_ag_log].type = ‘N’ 

iii. This button will only be enabled if the Property 
Year is not certified or if the Property is roll 
corrected. 

b. Delete 
i. This button will delete the focused row from the 

grid. 
ii. Confirmation will be asked prior to deleting the 

row. 
1. “Are you sure you want to delete the 

selected note?” 
iii. This button will only be enabled if the Property 

Year is not certified or if the Property is roll 
corrected. 

c. History 
i. This button will show the full log of notes for this 

Property. 
ii. Clicking this button will open the Ag Note History 

Dialog. 
3. This grid will have the following columns: 

a. Note 
i. This column will allow the user to view or edit the 

note’s text. 
ii. This column will be required. 

iii. This column will only be enabled if the Property 
Year is not certified or if the Property is roll 
corrected. 

iv. This column will allow up to 256 characters. 
v. When this is modified, the Date and User fields will 

be updated. 
vi. This column will be stored in 

[property_ag_log].content. 
b. Date 

i. This column will display the last date the note was 
edited or created. 

ii. This column will be read-only. 
iii. This column will be formatted as M/d/YYYY. 
iv. This column will be stored in 

[property_ag_log].changed_date. 
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c. User 

i. This column will display the last user that edited or 
created the note. 

ii. This column will be read-only. 
iii. This column will be stored in 

[property_ag_log].changed_by_user_id, but will 
display [pacs_user].pacs_user_name. 

 

5. Call/Visitor Log 
a. This new paragraph will have the following: 

i. Call/Visitor Log 
1. This grid will allow the user to view and enter call/visitor logs for 

the Property year that is open. 
a. This grid will display rows from [property_ag_log] where 

type = ‘C’, prop_id is the current property Id and year is 
the current property year. 

2. This grid will have a tool strip with the following buttons: 
a. New 

i. This button will create a new row at the top of the 
grid. 

ii. The new row will have an empty log but will fill the 
Date and User fields with the current date and the 
active user name. 

1. [property_ag_log].changed_date = Current 
Date 

2. [property_ag_log].changed_by_user_id = 
Active User Id 

3. [property_ag_log].type = ‘C’ 
iii. This button will only be enabled if the Property 

Year is not certified or if the Property is roll 
corrected. 

b. Delete 
i. This button will delete the focused row from the 

grid. 
ii. Confirmation will be asked prior to deleting the 

row. 
1. “Are you sure you want to delete the 

selected log?” 
iii. This button will only be enabled if the Property 

Year is not certified or if the Property is roll 
corrected. 

c. History 
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i. This button will show the full log for this Property. 

ii. Clicking this button will open the Ag Call Log 
History Dialog. 

3. This grid will have the following columns: 
a. Log 

i. This column will allow the user to view or edit the 
log’s text. 

ii. This column will be required. 
iii. This column will only be enabled if the Property 

Year is not certified or if the Property is roll 
corrected. 

iv. This column will allow up to 256 characters. 
v. When this is modified, the Date and User fields will 

be updated. 
vi. This column will be stored in 

[property_ag_log].content. 
b. Date 

i. This column will display the last date the log was 
edited or created. 

ii. This column will be read-only. 
iii. This column will be formatted as M/d/YYYY. 
iv. This column will be stored in 

[property_ag_log].changed_date. 
c. User 

i. This column will display the last user that edited or 
created the log. 

ii. This column will be read-only. 
iii. This column will be stored in 

[property_ag_log].changed_by_user_id, but will 
display [pacs_user].pacs_user_name. 
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Adding the VAB Indicator to the Property Header 

A new configuration will be added so that the user can specify whether the VAB Ag Granted Indicator 
will be visible. 

 

The new configuration will be accessible from Tools > System Configuration > System > Land > Enable Ag 
Granted Indicator. 

1. VAB Ag Granted: <Year> 
a. This field indicates that Ag has been granted by the VAB. 
b. This field will be displayed if the [property].ag_granted_year field is not null. 

i. This field is set in the Ag Info Panel. 
c. In addition to (b), this field’s visibility will be controlled by a configuration. 

 

New Code Maintenance Added for the New Ag panels 

Tool>Code file maintenance>Land > Ag status code  

Tool>Code file maintenance>Land > Ag VAB Code 

Tool>Code file maintenance>Land > Ag Access Code 

Tool>Code file maintenance>Land > Ag Letter Code 

Tool>Code file maintenance>Land > Ag Response Code 

Tool>Code file maintenance>Land > Ag Review Status Code 

New Panels Added 

Ag Status History Dialog 

The user will access this new dialog by going to Property View > Ag Info Panel > [Prior Year] Ag Status > 
History. 

 

This new dialog will contain: 

 

1) History Grid 
a. This grid will display the history of changes to the Ag Status information for a 

Property. 
i. This grid will display rows from [property_ag_status_history] where 

prop_id is the current property id. 
ii. This grid will be read-only. 

iii. This grid will be sorted by the Date column by default. 
iv. This grid will have the following columns: 
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1. Year 

a. This column will display the year layer in which this change 
was made. 

b. This column will be stored in 
[property_ag_status_history].year. 

2. User 
a. This column will display the user that made this change. 
b. This column will be stored in 

[property_ag_status_history].changed_by_user_id, but 
will display [pacs_user].pacs_user_name. 

3. Date 
a. This column will display the date in which the change was 

made. 
b. This column will be formatted as M/d/YYYY. 
c. This column will be stored in 

[property_ag_status_history].changed_date. 
4. Renewal 

a. This column will display the Ag Status. 
b. This column will be stored in 

[property_ag_status_history].ag_status_cd. 
5. Granted 

a. This column will display the Granted Acres. 
b. This column will be stored in 

[property_ag_status_history].granted_acres. 
6. Not In Ag 

a. This column will display the Not in Ag Acres. 
b. This column will be stored in 

[property_ag_status_history].not_granted_acres. 
7. Not In Ag Reason 

a. This column will display the Not in Ag Reason. 
b. This column will be stored in 

[property_ag_status_history].not_granted_reason. 
8. By 

a. This column will indicate whether the change was by Staff 
or VAB. 

b. This column will display “Staff” if the 
[property_ag_status_history].vab_ag_status_cd field is 
empty, otherwise it will show “VAB”. 

9. New Application 
a. This column will display the New Application Received 

date. 
b. This column will be formatted as M/d/YYYY. 
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c. This column will be stored in 

[property_ag_status_history].new_app_received_date. 
10. Green Card 

a. This column will display whether the Green Card was 
received or not. 

b. This column will be stored in 
[property_ag_status_history].green_card_scanned, but 
will display “Yes” or “No”. 

Ag Response History Dialog 

The user will access this new dialog by going to Property View > Ag Info Panel > Mailings > History. 

 

This new dialog will contain: 

1) History Grid 
a. This grid will display the history of changes to the Ag Response Date for a 

Property. 
i. This grid will display rows from [property_ag_response_history] where 

prop_id is the current property id. 
ii. This grid will be read-only. 

iii. This grid will be sorted by the Changed Date column by default. 
iv. This grid will have the following columns: 

1. Year 
a. This column will display the year layer in which this change 

was made. 
b. This column will be stored in 

[property_ag_response_history].year. 
2. User 

a. This column will display the user that made this change. 
b. This column will be stored in 

[property_ag_response_history].changed_by_user_id, but 
will display [pacs_user].pacs_user_name. 

3. Changed Date 
a. This column will display the date in which the change was 

made. 
b. This column will be formatted as M/d/YYYY. 
c. This column will be stored in 

[property_ag_response_history].changed_date. 
4. Response Date 

a. This column will display the recorded Response Date. 
b. This column will be formatted as M/d/YYYY. 
c. This column will be stored in 

[property_ag_response_history].ag_response_date. 
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Ag Note History Dialog 

The user will access this new dialog by going to Property View > Ag Inspection Panel > Notes > History. 

 

This new dialog will contain: 

 

1) History Grid 
a. This grid will display the history Ag Notes for a Property. 

i. This grid will display rows from [property_ag_log] where prop_id is the 
current property id and the type = ‘N’. 

ii. This grid will be read-only. 
iii. This grid will be sorted by the Date column by default. 
iv. This grid will have the following columns: 

1. Year 
a. This column will display the year layer in which this change 

was made. 
b. This column will be stored in [property_ag_log].year. 

2. User 
a. This column will display the user that made this note. 
b. This column will be stored in 

[property_ag_log].changed_by_user_id, but will display 
[pacs_user].pacs_user_name. 

3. Date 
a. This column will display the date in which the change was 

made. 
b. This column will be formatted as M/d/YYYY. 
c. This column will be stored in 

[property_ag_log].changed_date. 
4. Note 

a. This column will display the note’s text. 
b. This column will be stored in [property_ag_log].content. 
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Ag Call Log History 

The user will access this new dialog by going to Property View > Ag Inspection Panel > Call/Visitor Log > 
History. 

 

This new dialog will contain: 

 

1) History Grid 
a. This grid will display the history of Call/Visitor logs for a Property. 

i. This grid will display rows from [property_ag_log] where prop_id is the 
current property id and the type = ‘C’. 

ii. This grid will be read-only. 
iii. This grid will be sorted by the Date column by default. 
iv. This grid will have the following columns: 

1. Year 
a. This column will display the year layer in which this change 

was made. 
b. This column will be stored in [property_ag_log].year. 

2. User 
a. This column will display the user that made this note. 
b. This column will be stored in 

[property_ag_log].changed_by_user_id, but will display 
[pacs_user].pacs_user_name. 

3. Date 
a. This column will display the date in which the change was 

made. 
b. This column will be formatted as M/d/YYYY. 
c. This column will be stored in 

[property_ag_log].changed_date. 
4. Log 

a. This column will display the log’s text. 
b. This column will be stored in [property_ag_log].content. 

 

 

 

 


